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Release Notes
This document includes updated information for Oracle Application Testing Suite
version 13.3.0.1. The information in this document is more up-to-date than that in the
manuals. Many of the issues outlined in this document will be corrected in upcoming
releases. If you have any questions or problems, please contact our support group at 
https://www.oracle.com/support/.
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New Features and Updates in this Release
This version includes maintenance improvements to the existing features as well as
new features outlined below.

Oracle Application Testing Suite 13.3.0.1 July 2023 CPU - New
Features and Updates

• New Oracle Universal Installer for Oracle Application Testing Suite - The Next
Generation Oracle Universal Installer uses 64-bit JDK and fixes some of the
known installation issues.
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Note:

– The Oracle ATS product from the old installer needs to be removed
before using the New Installer. However, database can be reused by
selecting the Existing DB configuration.

– If you are selecting the "Existing DB configuration" while configuring
the database, then Master Password selected will not be having any
impact and the login password for OLT, OTM and Admin server will
still be having the old passwords.

• Changes to launch MS Edge browser with an additional parameter to prevent
browser restart during load test record.

• Record and Playback support for Save as dialog in Chrome.

• Bug fix in the closeAllBrowsers API. The method now supports forceful
termination of Microsoft Edge browser instance along with previously supported
termination of Chrome and Firefox instances.

• Openscript record and playback browser support for Chrome v113 and Edge v113.

• Bug fix in FormsAutomationEnabler.bat Command line tool:

– FormsAutomationEnabler.bat -enableForms true, enables the latest
installed versions of 32-bit and 64-bit JRE.

– FormsAutomationEnabler.bat -enableForms true -jre all, enables all the
installed JREs.

System Requirements
Oracle Application Testing Suite has the following system requirements:

Oracle Functional Testing/OpenScript

Oracle Functional Testing's OpenScript scripting platform has the following system
requirements:

• Operating System (64-bit versions only): Windows 10, Windows 11, Windows
Server 2016, Windows Server 2019, Windows Server 2022.

• Memory: Minimum 1 GB

• System: 64-bit processor, 2.6 GHz or faster

• Disk Space: 4 GB minimum

• Browsers: Firefox (64-bit ESR) 102.x; Chrome; Microsoft Edge.

• Oracle E-Business Suite: Oracle E-Business Suite Release 12 (Forms 10g)
running on Java SE Runtime Environment 8.

Oracle Load Testing
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Oracle Load Testing has the following system requirements:

• Operating System (64-bit versions): Windows 10, Windows 11, Windows Server
2016, Windows Server 2019, Windows Server 2022, Oracle Enterprise Linux 5.x,
6.x, 7.x. Windows Server 2016, Windows Server 2019, Windows Server 2022 are
supported systems for functional test-type scripts during load tests.

• Memory: Minimum 2 GB.

• System: 64-bit processor, 2.6 GHz or faster.

• Disk Space: 10 GB minimum free (at least 3 GB free on the system drive).

• Browsers: Firefox (64-bit ESR) 102.x, Chrome, Microsoft Edge.

• Database: Oracle EE 11g, EE 12c, XE 11g, 18c, 19c, 21c.

• Application Server: Oracle Fusion Middleware 12.2.1.4.0.

• Oracle Load Testing Agent also supported on Linux 64-bit, in addition to Windows
64-bit operating systems listed above.

Note:

These are minimum requirements only and actual requirements for the
Oracle Load Testing Server will vary depending on the size and
configuration of your load test. If you are running larger load tests, of
greater than 1000 Virtual Users, you should consider deploying Oracle
Load Testing on a faster server class machine with additional RAM
recommended.

Note:

Oracle recommends running the Oracle Load Testing Server and Agents
on separate systems for production load testing. The amount of memory
required on the Oracle Load Testing Agent systems may increase based
on the number of Virtual Users that will be assigned to run on each
Agent. For more information, visit the QA/Testing Technology Center on
Oracle Technology Network or contact your Oracle representative.

Oracle Test Manager

Oracle Test Manager has the following system requirements:

• Operating System (64-bit versions): Windows 10, Windows 11, Windows Server
2016, Windows Server 2019, Windows Server 2022, Oracle Enterprise Linux 5.x,
6.x, 7.x.

• Memory: Minimum 2 GB.

• System: 64-bit processor, 2.6 GHz or faster.

• Disk Space: 10 GB minimum free (at least 3 GB free on the system drive).
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• Browsers: Firefox (64-bit ESR) 102.x, Chrome, Microsoft Edge.

• Database: Oracle EE 11g, EE 12c, XE 11g, 18c, 19c, 21c.

• Application Server: Oracle Fusion Middleware 12.2.1.4.0.

Note:

These are minimum requirements only and actual requirements for
Oracle Test Manager will vary depending on the quantity of test assets
stored and number of concurrent users accessing the application. If you
have a large quantity of test cases, requirements or issues stored and/or
are deploying Oracle Test Manager for a team greater than 10 users, you
should consider deploying Oracle Test Manager on a faster server class
machine with additional RAM recommended.

Additional Notes

The following are additional notes about system requirements:

• The Oracle database must be downloaded and installed separately before the ATS
download and install.

• System memory requirements do not take into account other processes that may
be running and using memory on your system, reducing free uncommitted memory
available.

• When installed on the same machine, Oracle Load Testing and Oracle Test
Manager will run on the same server and use shared system resources. Oracle
Functional Test/OpenScript is a separate application that has its own memory and
CPU requirements.

• Oracle Load Testing allows you to distribute your Virtual Users to run from remote
Agent machines. Users must install the Agent-Only Remote Agent install
component on their Agent machines to enable this functionality.

• When recording and playing back EBS/Forms functional test scripts, all JRE Plug-
in security dialogs are automatically suppressed. Unsigned, self-signed and other
security vulnerable applications can be automatically allowed to run.

Installing the Oracle Application Testing Suite
See the Oracle Application Testing Suite Installation Guide.

Manual Browser Configuration
This section lists the manual configuration which would enhance the overall usability of
the application. All the configurations listed are optional.

1. Google Chrome Policies

• AutoOpenFileTypes:
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This policy sets a list of file types that should be automatically opened on
download..

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\AutoOpenFileTy
pes

Create a new String with key in numerical order starting from 1 and value of
the extension, which needs to be auto opened. Eg. jnlp.

• AutoOpenAllowedForURLs
A list of URLs to which AutoOpenFileTypes will apply to.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\AutoOpenAllowe
dForURLs

• PopupsAllowedForUrls
Setting the policy lets you set a list of URL patterns that specify the sites that
can open pop-ups.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\PopupsAllowedF
orUrls

• SafeBrowsingAllowlistDomains
Setting the policy to Enabled means Safe Browsing will trust the domains you
designate. It won't check them for dangerous resources such as phishing,
malware, or unwanted software.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\SafeBrowsingAllowlistD
omains

Note:

For more details of Google Chrome policies, refer to the Google Chrome
Official Documentation

2. Microsoft Edge Policies

• AutoOpenFileTypes
This policy sets a list of file types that should be automatically opened on
download. You can use the AutoOpenAllowedForURLs policy to restrict the
URLs for which these file types will be automatically opened on.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\AutoOpenFileT
ypes

• AutoOpenAllowedForURLs
A list of URLs to which AutoOpenFileTypes will apply to.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\AutoOpenAllow
edForURLs

5

https://chromeenterprise.google/policies/
https://chromeenterprise.google/policies/


• PopupsAllowedForUrls
Define a list of sites, based on URL patterns, that can open pop-up windows.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\PopupsAllowed
ForUrls

• SmartScreenAllowListDomains
Configure the list of Microsoft Defender SmartScreen trusted domains. This
means: Microsoft Defender SmartScreen won't check for potentially malicious
resources like phishing software and other malware if the source URLs match
these domains.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\SmartScreenAl
lowListDomains

• ExemptFileTypeDownloadWarnings
You can enable this policy to create a dictionary of file type extensions with a
corresponding list of domains that will be exempted from file type extension-
based download warnings.

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\ExemptFileTyp
eDownloadWarnings

Note:

For more details on Microsoft Edge policies, refer to the Microsoft Edge
Official Documentation

Tutorial and Documentation for the Oracle Application
Testing Suite
The Oracle Application Testing Suite includes product documentation in Adobe
Acrobat .PDF format and online help for each application and utility. The
documentation includes electronic versions of the Getting Started Guide, OpenScript
User's Guide, Oracle Load Testing User's Guide, Oracle Test Manager User's Guide
and Release Notes. The PDF files are installed to the <installDir>/docs directory.

You need the Adobe® Acrobat® Reader to open and view the documents. You can
download the reader from the Adobe web site at https://get.adobe.com/reader/.

All of the components of the Oracle Application Testing Suite include comprehensive
online Help. You can access the online help using the Help menu options inside of
each product.

Known Problems, Limitations and Workarounds
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This section lists known issues and workaround solutions for the components in the
Oracle Application Testing Suite.

Note:

On Windows systems with UAC enabled, it is necessary to run commands
from an elevated command line in order to restart services. If you try to run it
from the Start menu, you will see the following errors in the cmd window:

System error 5 has occurred.
Access is denied.

Run services.msc from the command line and restart the services from
there. Windows systems with UAC enabled require administrator privileges
to run commands from an elevated command line in order to stop and restart
services.

Oracle Application Testing Suite

The following are known issues and workaround solutions for Oracle Application
Testing Suite.

• After launching the installer (setup.bat in Windows or setup.sh in Linux), there will
be a 2-3 min delay before the installation wizard is seen. This delay is mainly due
to the background operation being performed by installer.

• Problem: After you install, you can't login to Oracle Load Testing, Oracle Test
Manager, Oracle Administrator, etc.

Resolution: During install, you will be prompted for a Master password to use in
the various OATS products where passwords may be required. It's important that
you remember or write down this password as it will be needed to login to these
applications (username will typically be "default" or "administrator"). If you don't
remember the password, you will have to re-run the installer and establish a new
default password. The passwords can be changed and new user accounts added
through the Administrator after install.

Oracle Load Testing

The following are known issues and workaround solutions for Oracle Load Testing.

• Problem: Some Virtual Users continue running after reaching the specified Test
Goal in the Autopilot using After a delay of setting set to (00:00:00).

Resolution: Increase the After a delay of (hh:mm:ss) setting to greater than zero.
For example, 00:00:01.

• Problem: Data Transmission Interruption when loading many graphs or when
trying to create graphs from very large data sets using Internet Explorer.

Resolution: Reduce the Data Granularity in the Advanced tab of the graph
options. Set the Max. Data Points to a lower value. For example, from 100 to 50.
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• Problem: Siebel Functional Test script playback halts on Auto Fix dialog box
waiting for user interaction causing script failure.

Resolution: Verify the correct version of Java is installed. Workaround is to
disable the "Auto fix" dialog box from appearing in the Seibel application, as
follows:

1. Log into the Siebel application.

2. Site Map (globe icon in the upper right corner).

3. Select Administration then Server Configuration.

4. Select Component Definitions.

5. Select Query (for the top grid).

6. Search for SCCObjMgr* in the Alias field (assuming the Siebel application is
CallCenter).

7. Select Query in the bottom grid.

8. Search for the EnableClientHealthCheck parameter.

9. Set value to FALSE.

10. Restart the Siebel service.

• Problem: Database ServerStats not working on non-US systems.

Resolution: In <installdir>\DataCollector\properties, save a backup of the
jagent_service.properties file.

Open the jagent_service.properties file and find the line:

JHP.commandline = -Xmx1024M -Dsun.java2d.noddraw=true -cp "${JHP.classpath}" 
-Dsun.net.inetaddr.ttl="0" oracle.oats.dc.fw.jhp.JHPmain ${JHP.server} -
logsize 2000000 -logparts 2 "${JHP.installDir}\\DataCollector\\properties 
agents.properties"

and change it to:

JHP.commandline = -Xmx1024M -Duser.language=en -Duser.country=US -
Dsun.java2d.noddraw=true -cp "${JHP.classpath}" -Dsun.net.inetaddr.ttl="0"
oracle.oats.dc.fw.jhp.JHPmain ${JHP.server} -logsize 2000000 -logparts 2 "$
{JHP.installDir}\\DataCollector\\properties agents.properties" 

Save the file and restart the agent starter service.

• Problem: Data Collector being forced to authenticate as Guest, no matter what
credentials are used causing the error Logon failure: unknown user name or bad
password.

Resolution: Change the machine's local security policy to "Classic" to be able to
discover Perfmon counters using the local account (Administrator). See the
following for additional information:

http://msdn.microsoft.com/en-us/library/ek2256kk.aspx
• Problem: If a Data Collector process (olt-dc-java-agent.exe) was running and you

restart the Oracle Load Testing server and attempt to do something with
ServerStats on the server (start a metric, for instance), it will start a second Data
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Collector process that will not function properly because of the lock established by
the first process.

Resolution: To address this, end the Data Collector process(es) manually, delete
the lock file(s) ($installDir\DataCollector\bin\*.pid), then repeat the
ServerStats task attempted previously.

• Problem: If your script fails to playback successfully in Oracle Load Testing due to
Windows authentication or other user permissions related issues with your
application, this may be due to the login authentication of the Oracle Load Testing
Agent Service. The Oracle Load Testing Agent Service which runs all the Virtual
Users on a given Agent system will by default be installed to run under the Local
System account. This may cause issues for certain applications if they block
access to this account.

Resolution: To address this, open the Oracle Load Testing Agent Service in the
Services panel and change the login to run under a specific user with appropriate
application permissions.

• When using the SNMP data source, new SNMP MIBs that users specify are
uploaded to the Oracle Load Testing Server by default and can be accessed only
through the Local Oracle Load Testing Data Collector running on that Server.
Remote Oracle Load Testing Data Collectors cannot access these MIBs and users
need to copy those over manually.

• Problem: When bringing up Oracle Load Testing (or Oracle Test Manager) you get
the following error reported by the browser: "Unable to connect" or "Can't establish
a connection to the server at localhost:8088."

Resolution: This error indicates that the OATS Application Service is not running.
Start (or restart) the OATS Application Service on the server machine where you
installed OATS server. You will also want to make sure that the Oracle Database
services are also running (this would be OracleServiceXE and
OracleXETNSListener if you used the Oracle XE database).

• Problem: When bringing up OLT (or OTM) you get the following error reported by
the browser: "Error 404--Not Found"

Resolution: This error indicates that the OATS Application Service is unable to
connect to the Oracle Database. You will also want to make sure that the Oracle
Database services are also running and start/restart them if necessary (this would
be OracleServiceXE and OracleXETNSListener if you used the Oracle XE
database). Then restart the OATS Application Service.

• The remote ServerStats Data Collector requires the Agent-Only installation for the
Remote Agent installed on the remote Data Collector machine.

Oracle Test Manager

The following are known issues and workaround solutions for Oracle Test Manager.

• Adding/editing test steps to a test case will not sync the changes with uncompleted
Test Set Runs created before upgrading to 12.5.0.1. The Test Set Runs created
after upgrading to 12.5.0.1, which are not completed, will reflect new changes
made to test steps.
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• Remote execution of JUnit tests or execution of JUnit tests is not supported on
Linux. Support for this is planned for a future release.

• The icons in the Tree View for Test Plans, Requirements, Tests, and Issues are
automatically assigned and cannot currently be configured by the Administrator.

• After configuring a new database in the Oracle Test Manager Database
Configuration dialog, users must restart the Oracle Application Testing Suite
Application Service in order for that database to appear in the Database dropdown
list on the Oracle Test Manager login page.

• Problem: A warning message appears indicating there are duplicate custom field
names when logging into the Administrator (http://hostname:8088/admin) to
upgrade the OTM database.

Resolution: The field name(s) listed in the warning message must be renamed
before the upgrade can be completed. The field name(s) listed in the warning
message will be different depending on each user's situation. Perform the
following steps to rename the fields listed in the warning message:

1. Make a note the duplicate field names in the message and click OK to dismiss
the warning message.

2. Connect to the OTM schema and execute the following SQL statement to find
the customfieldid. In the example below, the query looks for the
customfieldid for 'Cycle'. You will need to replace 'Cycle' with the actual field
name that your upgrade is warning about. The query should return multiple
results. Note the customfieldid for one of the results because it will be used
in step 3.

SQL> select customfieldid from "Custom_Field" where name = 'Cycle';
3. The update statement below will change the custom field name for the

referenced customfieldid.

– Replace the name with another name that makes sense but is not a
duplicate (i.e. 'Cycle1').

– Replace the customfieldid with the value obtained from step 2.

SQL> update "Custom_Field" set name='Cycle1' where customfieldid=32;
1 row updated. 

4. Commit the change to save it.

SQL> commit;
Commit complete. 

5. Go to http://hostname:8088/admin and log into the OTM database again to
upgrade it.

• Problem: Unable to delete Test Results for a Test executed in a Test Set after the
Test Set has been deleted from the Test Execution tab (the Test Run appears in
the Run History section of the Test on the Tests tab but the Run does not appear in
the Delete Results list).

Resolution: Delete the Test Results from the Run History section of the Test Set
on the Test Execution tab before deleting the Test Set. If you delete the Test Set
before deleting the Test Results from the Run History section of the Test Execution
tab, the Test Results will still appear in the Run History section of the Tests tab.
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However, the Test Result from the Test Set run cannot be deleted from the Run
History on the Tests tab.

• Problem: Any chart report with the "Version" field as first field will not show any
data in the data-view.

Resolution: Do not use the "Version" field as first field.

• Problem: Unable to move tree nodes up beyond Previous indicator or down
beyond Next indicator in the tree view. Move operation results in a "Move
Operation Failed. Please ensure the node selection is valid." warning message.

Resolution: Increase the number of displayed nodes in the user options. Select
Options from the Tools menu, select Tree Preferences and increase the
Maximum Number of Displayed Nodes value.

• Problem: Goto does not work for Tree grouped by "Run By" or "Las Run Status".
This issue may occur after upgrade from Oracle Application Testing Suite pre-9.3x.

Resolution: Perform the following updates against the Oracle Test Manager
database:

1. Stop ATS service.

2. Open a command prompt.

3. Type sqlplus <schemaname>/<password><@service>.

4. When connected to the schema, paste following queries:

UPDATE "Special_Field" SET SpecialFieldId=23, label = 'Last Run By' 
WHERE AttachedToTypes=8 and Name='runbyuser'; 

UPDATE "Special_Field" SET SpecialFieldId=24 WHERE AttachedToTypes=8 and 
Name='duration'; 

UPDATE "Special_Field" SET SpecialFieldId=25, Type=7 WHERE 
AttachedToTypes=8 and Name='rundate';

commit;
5. Type quit to exit from sqlplus.

6. Type exit to close the command window.

7. Start the ATS service.

• Problem: Exceptions occur or application hangs when attempting to export
extremely large projects (projects exceeding 11,000 test cases).

Resolution: For large databases, change Stuck Thread Max Time parameter
(default value is 600, i.e. 10 min.) for the server using the following steps:

1. Close all OATS applications.

2. Open a browser and go to http://localhost:8088/console/ (or http://
<server>:8088/console/).

3. Log into WebLogic Server (username "oats", password defined during OATS
installation).

4. Expand the Environment tree under Domain Structure (left pane).
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5. Select Servers.

6. Click the AdminServer(admin) link under Servers (right pane).

7. Click the Tuning tab.

8. Change the value for parameter "Stuck Thread Max Time" to a larger
appropriate value.

9. Click Save then restart the application server.

• Problem: Oracle Test Manager fails to playback certain OpenScript scripts
completely.

Resolution: The following additional steps are required in order to run the
following types of OpenScript scripts from Oracle Test Manager:

– Siebel Functional

– Oracle Forms Functional

– Web Functional scripts that rely on system input events, such as key press or
mouse click

– Web Functional scripts that display modal dialog windows

It is necessary to run these scripts using an interactive desktop of a named
Windows user account that is always logged in. See also "Command-Line Script
Execution" for additional information.

1. For Siebel and Oracle Forms, the named user's account must have visited the
Siebel or Oracle Forms site at least once to ensure that all necessary ActiveX
controls and plug-ins are installed in the named user's browser.

2. On the Oracle Test Manager agent machine that will run the scripts, stop the
"Oracle ATS Agent" service.

3. On the Oracle Test Manager agent machine, login as the named Windows
user account that will run the scripts. From a command prompt, run the
following:

Note:

For Windows systems, the command must be run using the elevated
command line. From the Start menu, expand the Accessories, right
click on the Command Prompt menu option and select Run as
administrator from the shortcut menu.

Windows:

$installDir\agentmanager\bin\agentmanager.cmd

Linux:

$installDir\agentmanager\bin\agentmanager.sh
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This command starts a Java executable running the agentmanager, it will not
"run" the service. All output is logged to the agentmanager.log and the logs of
individual agents.

If you get the following error then the 'Oracle ATS Agent' service has not been
stopped.

java.lang.InterruptedException
 at java.lang.Object.wait(Native Method)
 at 
oracle.oats.empstart.PortListener.getContRequest(PortListener.java:276)
 at 
oracle.oats.empstart.EmpStartMain.parseRequests(EmpStartMain.java:1240)
 at oracle.oats.empstart.EmpStartMain.<init>(EmpStartMain.java:515)
 at oracle.oats.empstart.EmpStartMain.main(EmpStartMain.java:421)

Stop the 'Oracle ATS Agent' service and run the command again.

4. The named user account must remain logged into the system at all times that
scripts will be run.

• Problem: When bringing up Oracle Load Testing (or Oracle Test Manager) you get
the following error reported by the browser: "Unable to connect" or "Can't establish
a connection to the server at localhost:8088."

Resolution: This error indicates that the OATS Application Service is not running.
Start (or restart) the OATS Application Service on the server machine where you
installed OATS server.

You will also want to make sure that the Oracle Database services are also
running (this would be OracleServiceXE and OracleXETNSListener if you used the
Oracle XE database).

• Problem: When bringing up Oracle Load Testing (or Oracle Test Manager) you get
the following error reported by the browser: "Error 404--Not Found"

Resolution: This error indicates that the OATS Application Service is unable to
connect to the Oracle Database. You will also want to make sure that the Oracle
Database services are also running and start/restart them if necessary (this would
be OracleServiceXE and OracleXETNSListener if you used the Oracle XE
database). Then restart the OATS Application Service. See the above note about
stopping and restarting services on Windows systems.

Oracle Functional Testing - OpenScript

The following are known issues and workaround solutions for Oracle OpenScript.

• Problem: EBS/Forms and OpenScript both hang during recording.

Resolution: Use of a network drive for storing scripts can cause the application to
hang while recording EBS/Forms load scripts due to the volume of data being
recorded and stored to the network location instead of a local disk. OpenScript
writes all of the headers and content to the remote network drive that the
application-under-test sends to the browser client. When recording into a remote
drive, network limitations may limit the writing speed causing a large volume of
data waiting to be written. This can cause an OpenScript out-of-memory error and
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application hang. It is recommended to record EBS/Forms load scripts to a local
drive or verify network bandwidth.

• Problem: OpenScript playback error occurs if the script contains UTF-8
characters. The failure may occur as a Replay Action failed and UTF-8 characters
are converted to question mark (?) characters.

Resolution: Set the OpenScript -Dfile.encoding=UTF8 startup property as
follows:

1. Close OpenScript.

2. Right-click the OpenScript startup icon/menu option on the Start menu (or
Desktop icon, if available).

3. Select Properties.

4. Add the -Dfile.encoding=UTF8 property setting to the end of the Target string
on the Shortcut tab. The full Target string should be as follows:

C:\OracleATS\openScript\OpenScript.exe -configuration 
openscript_configuration -vm C:\OracleATS\openScript\jre\bin\javaw.exe -
vmargs -Xmx512m -XX:MaxPermSize=256m -Dfile.encoding=UTF8

5. Click OK to close the OpenScript Properties.

6. Restart OpenScript using the modified OpenScript Start icon/menu option (or
Desktop icon) and playback the script.

• Problem: OpenScript captures HTTP requests that are for Google use when using
Google Chrome to record HTTP module scripts. Some examples are as follows:

www.google.com/searchdomaincheck
ssl.gstatic.com
safebrowsing-cache.google.com
safebrowsing.google.com
productforums.google.com
www.googletagmanager.com
www.youtube.com
fonts.gstatic.com
clients4.google.com
www.youtube-nocookie.com

Resolution: Define URL filters for unnecessary URL requests, a follows:

1. Start OpenScript and open an HTTP module script.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript peferences and select HTTP under the Record
preferences.

4. Open the URL Filters tab.

5. Click Add.

6. Specify a name and URL pattern for each URL you do not want OpenScript to
capture. Specify Match as URL and Method as Wild card.

7. Click OK to save the filter.

8. Repeat Steps 5 through 7 for each URL.
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9. Click OK to save the preferences.

• Problem: OpenScript cannot check Float type values retrieved from a database
table using == to check whether or not two values are equal.

Resolution: Use a SQL statement such as "select to_char(columnname) as
columnname from table" and check the values in OpenScript as String type.

• Problem: Login dialog is not recognized by Chrome browser during Web
Functional test script playback.

Resolution: Modify the script's navigation code to use the following URL format
for the login navigation for Chrome browser playback (this format is supported by
all browsers):

String URL = "https://Username:password@WebURL"; 

where webURL is the original URL needed for the login navigation.

• Problem: Automatic proxy configuration (Preferences - OpenScript - Record -
HTTP Module) for Firefox may not correctly configure the browser proxy.

Resolution: To record through Firefox, you should configure the browser proxy
settings manually (Default: host=localhost, port=7777).

• Problem: Certain systems may have trouble launching the OpenScript Help (Help
- Help Contents).

Resolution: This can be resolved by configuring the help to open in an external
browser window:

1. From the Tester Perspective, select View - OpenScript Preferences.

2. Click the "Clear" icon next to the filter text field in the upper left. Click the Help
tree node and check the "Use external browser" box in the Help preferences.

3. Click OK and relaunch OpenScript Help.

• Problem: When recording a functional testing script you get the following error:
“Cannot connect to browser".

Resolution: The browser did not come up in the required amount of time when
you clicked the Record button. This could be because the machine was busy or
the ATS OpenScript browser extensions for Chrome, Edge or Firefox were not
loaded properly. You can try increasing the browser “Startup timeout" setting under
OpenScript Preferences, General…Browser section. If that does not work, run the
OpenScript Diagnosis Tool under OpenScript Help.

• Problem: When recording a functional testing script, you do not see any actions
added to the script after recording.

Resolution: The browser extension is not capturing events and sending them to
OpenScript during recording. Run the OpenScript Diagnosis Tool under
OpenScript Help. The Diagnosis Tool will attempt to correct any browser extension
loading problems, and report any failures it encounters. You can also try switching
the browser between Chrome, Edge or Firefox to see if that works better.

• Problem: When you record a Web load test script, you do not see any navigations
added to the script after recording.
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Resolution: OpenScript uses an HTTP proxy server between OpenScript and the
target application when you record Web load test scripts. If your browser is
accessing the Web via a proxy, you may need to chain that proxy through
OpenScript's HTTP recording preferences. OpenScript will attempt to chain the
proxy automatically for you using the browser's proxy settings. If you do still have
problems recording HTTP navigations, check the “HTTP" Record preferences for
network interface and proxy settings.

• Problem: When recording an Oracle EBS/Forms functional testing or load testing
script, the browser appears to hang when loading the Oracle Forms applications
and you are not able to continue.

Resolution: The system you are using to record your script may not have the
proper JRE version required to run the Oracle Forms applications. Before you start
recording Oracle EBS/Forms functional testing or load testing scripts, step through
the EBS/Forms transaction once in the browser stand-alone (i.e. while not
recording) to make sure you have the proper JRE installed and confirm that the
Forms applications run properly – then try to re-record your script.

Web Functional Test Recording with Firefox Troubleshooting

The following section describes Web Functional Test Recording with Firefox
Troubleshooting techniques.

• When using the Firefox browser, you should disable or not install any add-ons into
the OpenScript-created Firefox profiles.

Command-Line Script Execution

The following are tips, known issues, and workaround solutions for running OpenScript
scripts from the Command-Line Interface (CLI).

• Problem: Playback does not recognize objects outside of the visible window area.
(Note: this is also applicable to playback of scripts from the OpenScript UI.)

Resolution: When playing back scripts, make sure the browser window is the
same size as when the script was recorded. One way to ensure that the browser is
the same size is to record the script with the browser window maximized, then add
a web.window("path").maximize() method to the script code before playing back
the script. Also, make sure the machine used to play back the script is set to the
same screen resolution as the machine used to record the script.

• Problem: Playback does not recognize recorded keyboard actions.

Resolution: When recording scripts for command-line execution, use mouse
clicks instead of keyboard actions to interact with the application-under-test. For
example, when filling in forms, click the mouse on the form fields before entering
text rather than using the Tab key. Also, click the Submit button with the mouse
rather than pressing the Enter key.

• Problem: Playback does not work with Remote Desktop minimized.

Resolution: Make sure the Remote Desktop is visible/maximized before playback.
Alternatively, you can add the RemoteDesktop_SuppressWhenMinimized value to
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the Registry of the system from which you are running the command-line interface,
as follows:

Caution:

The following procedures modify your system Registry. Modifying the
system Registry carries risk of causing serious problems that may affect
the operation of your operating system software. Use the information
provided at your own risk.

1. Close any currently open Remote Desktop connections.

2. Select Run from the Start menu.

3. Type regedit and click OK.

4. Expand one of the following Registry keys depending upon the system and
which user account you want to use for the command-line execution:

– for 32-bit current user account:

HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client
– for 32-bit all user accounts:

HKEY_LOCAL_MACHINE\Software\Microsoft\Terminal Server Client
– for 64-bit current user account:

HKEY_CURRENT_USER\Software\Wow6432Node\Microsoft\Terminal Server 
Client

– for 64-bit all user accounts:

HKEY_LOCAL_MACHINE\Software\Wow6432Node\Microsoft\Terminal Server 
Client

5. Select New from the Edit menu, then select DWORD (32-Bit) Value.

6. Enter RemoteDesktop_SuppressWhenMinimized as the name and press Enter.

7. Double-click the RemoteDesktop_SuppressWhenMinimized registry entry to
open the edit dialog box.

8. Specify 2 in the Value Data field and click OK.

9. Close the Registry Editor.

• Problem: Need to automatically initiate a Remote Desktop connection after a
reboot.

Resolution: You can initiate a Remote Desktop connection after rebooting the test
machine using a saved Remote Desktop Protocol (.rdp) file for a Remote Desktop
connection.

To specify and save a Remote Desktop Protocol file:

1. Select Accessories from the Start menu, then select Remote Desktop
Connection.
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2. Click the Options button.

3. Specify the Logon settings in the General tab.

4. If you wish to be able to start the Remote Desktop Connection without being
prompted for credentials (user and password), select Allow me to save
credentials.

5. If you wish to automatically start a program on the Remote Desktop
connection, click the Programs tab and specify the program to start.

6. Click the Connect button.

7. Enter the username and password and click OK.

8. Close the Remote Desktop connection.

9. Select Accessories from the Start menu, then select Remote Desktop
Connection.

10. Click the Options button.

11. Select the General tab, if necessary, and click Save As.

12. Specify the directory and file name for the .rdp file and click Save.

13. If you wish to automatically scale the Remote Desktop when connecting, edit
the saved .rdp file in a text editor and add the following setting to the end of
the settings:

smart sizing:i:1
14. Schedule the .rdp file to launch automatically after a reboot/restart using Task

Scheduler or create a batch file on the test machine using a text editor with the
following command:

mstsc c:/myRdpFile.rdp

where myRdpFile is the name you used to save the Remote Desktop
connection file.

15. If you use a batch file, schedule the batch file to run using a tool that is
capable of launching the batch file automatically after a reboot/restart.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at https://www.oracle.com/corporate/
accessibility/.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit https://support.oracle.com/
portal/ or visit https://www.oracle.com/corporate/accessibility/learning-
support.html#support-tab if you are hearing impaired.
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